**Table of Contents**

Make a movie with photos, video clips and music ................................................................. 2

Adding Photos .......................................................................................................................... 2
Adding Transitions .................................................................................................................. 3
Adding and trimming video clips ............................................................................................ 4
Adding a Title .......................................................................................................................... 5
Adding Audio/Music ................................................................................................................ 6
Adding narration to your movie ............................................................................................... 7
Adding Credits ......................................................................................................................... 8
Getting Ready to Publish ......................................................................................................... 8
Create videos with AutoMovie ................................................................................................ 9
Publishing Options .................................................................................................................. 10
Copyright ................................................................................................................................ 12
Finding Images Online .......................................................................................................... 13
Finding Music Online ............................................................................................................. 14
Troubleshooting Music Files ................................................................................................ 15

It is recommended that you use a thumb drive in creating a book trailer. The “quota” on your computer will quickly run out.
Make a movie with photos, video clips and music

In Windows XP, you can make a movie out of your photos using Windows Movie Maker. Your photo movie can contain a combination of still photos, video clips, and audio.

Adding Photos

1. Click **Start**, point to **All Programs**, and then click **Windows Movie Maker**.

2. In the **Movie Tasks** pane, under **Capture Video**, click **Import pictures**, and then, in the **My Pictures** folder, select the photos you want to use.

If you are using photos from multiple folders in the **My Pictures** folder, repeat this step until you have imported all of the pictures you plan to use for your movie.

3. Click **Import audio or music**, and then, in the **My Music** folder, select the music file you are going to use.

The **Contents** pane will display the photo and music files that you selected.

4. Drag a photo to the first box in the storyboard at the bottom of the **Movie Maker** window. Continue to add photos to the storyboard in the order you would like them to appear in your movie.

If you want to move a photo within the storyboard, drag it to a new position.
**Adding Transitions**

1. In the *Movie Tasks* pane, under *Edit Movie*, click *View video transitions*.

2. In the *Contents* pane, drag transitions into the storyboard, placing them between your shots.

*Note:* You may need to click the triangle next to *Edit Movie* to expand/collapse the menu items.
Adding and trimming video clips

When you download video from your camera to your computer, Windows Movie Maker by default will split longer video into shorter clips. These clips were created when you stopped or paused recording with your camera.

If you notice that Movie Maker did not automatically split your video into clips, you can turn this option on, and then trim your video clips to show the most important moments.

To create video clips

1. Under Capture Video, click Import Video.
2. On the Import File dialog box, select the Create clips for video files check box.
3. Click your video file, and then click Import.
4. In the Collection pane, right-click the video, and then click Create Clips.

To trim video clips

1. Drag clips from your collection to the storyboard at the bottom of the window.
2. Select the clip you want to trim, and then, in the Preview Monitor, click the Play button.
3. Play the clip until it gets to where you want to trim it, then click the Split Clip button. This cuts your clip into two separate clips that are added to your storyboard.
4. Delete the portion of the clip you don't want by right-clicking it, and then clicking Delete. Repeat for each clip. You can split clips several times to use more than one moment from a clip.

If you do a lot of editing, you might want to use the timeline view, which shows you how long each clip will play. Click the Show Timeline button on your storyboard.
Adding a Title

1. In the Movie Tasks pane, under Edit Movie, click Make titles or credits, and then click Add title at the beginning of the movie.

2. Type your title, and then click Done, add title to movie.

The title you created will appear in the first position of the storyboard.

Remember to add a transition between your title and the first photo.

Change the animation of your title by clicking Change the title animation and choosing from the available options.

Change the font style/color and background color by clicking Change the text font and color.
Adding Audio/Music

1. In the toolbar located above the storyboard, click **Show Timeline** to change the view of your workspace to a timeline.

2. On the **Movie Maker** toolbar, click the **Location** drop-down box, and then click **Collections**.

3. Drag your music file from the **Contents** pane to the **Audio/Music track** in the timeline. Be sure the music file is positioned all the way to the left of the Audio/Music track.

4. To adjust the music to end where your pictures end, click the end of your music file, and drag it to align with the end of your last photo.

5. To add a fade-out effect to your music, right-click the music file, and then click **Fade Out**.
Adding narration to your movie

If you'd like to describe what's happening on-screen, you can record yourself speaking over your movie.

To add narration

1. Verify that your microphone is turned on. If you don't have a built-in microphone on your computer, connect an external microphone.

2. Download video from your camera. To learn how, see Download video from your camera to your computer.

3. In Movie Maker, click the Tools menu, and then click Narrate Timeline. If prompted, click OK.

4. On the timeline, click the clip you want to narrate. Before you begin, speak into your microphone, and adjust the Input level so that the bar is about halfway up when you are speaking.

5. Under Narrate Timeline, click Start Narration. Speak into your microphone as Movie Maker plays your movie. You can narrate your entire movie at once or just one clip at a time. When you're done narrating, click Stop Narration.

6. Movie Maker will save your narration as a separate file. In the Save Windows Media File dialog box, type a name for your narration, and then click Save.

7. In the Preview Monitor, click Play to watch your movie and listen to the narration.

If the narration is too loud or too soft, right-click the narration bar on your timeline, and then click Volume. In the Audio Clip Volume dialog box, adjust the slider to the right or left, and then click OK.

To delete narration so that you can re-record it, right-click the narration on the timeline, and then click Delete.
**Adding Credits**

1. To add credits, in the **Movie Tasks** pane, under **Edit Movie**, click **Make titles or credits**, and then click Add credits at the end of the movie. This will look very similar to adding a title at the start of your movie.

2. Type your credits, and then click **Done**, add credits to movie.

The credits you created will appear in the last position of the storyboard.

**Getting Ready to Publish**

1. To preview your movie, use the controls in the **Preview Monitor**.

3. If you're satisfied with your movie, click the **File** menu, and then click **Save Project**.

4. In the **Movie Tasks** pane, under **Finish Movie**, click **Save to my computer**.

5. In the **Save Movie Wizard**, type a name for your movie, and then click **Next**.

By default, Movie Maker saves the movie file to the **My Videos** folder.

*If you have a long video, you will want to save to a flash drive, or your C: drive, until you can burn a copy to disk.*

To change the default location, click **Browse**.

Find the C: drive and the folder you set up for video files there.

6. On the **Movie Setting** page, select a setting to save your movie in, and then click **Next**.

By default, **Best quality for playback on my computer (recommended)** is selected.

This setting is recommended if you plan to just play your movie from your computer or save it to a CD.

If you plan to send your movie by e-mail, click **Show more choices**, and then select **Video for broadband**, **Video for ISDN**, or **Video for dial-up access** to best match the Internet access speed of those you are sending the movie to.

7. When Movie Maker is done saving your movie, click **Finish**.

You can make multiple versions of your photo movie by repeating this process and choosing a different setting for each version (one for e-mail, another for CD, and so on) before you close your project file. Be sure to save each movie with a unique file name that you can easily identify later.

If you saved your movie to your C: drive, be sure to save a backup copy in another file location to avoid losing your work in the event of a computer problem.
**Create videos with AutoMovie**

With Windows Movie Maker, you can use AutoMovie to create a professional-looking movie with a title screen and background music. Download your video into Movie Maker, select an editing style, choose a title and background music, and let AutoMovie do the work for you.

**To create videos**

1. In the **Movie Tasks** pane, under **Capture Video**, click **Import video**. Navigate to the folder you created on the C: drive with the picture and audio files. Choose a video to import.

2. An alternative would be to connect your camera to your computer, and download your videos into Movie Maker.

3. Movie Maker will create a **group of video clips** from your movies.

4. In the **Movie Tasks** pane, under the **Edit Movie** menu, click **Make an AutoMovie**.

5. On the **Select an AutoMovie Editing Style** page, click a style. Choices include **Flip and Slide**, **Highlights Movie**, **Music Video**, **Old Movie**, and **Sports Highlights**.

6. Under **More options**, click **Enter a title for the movie**. In the **Enter Text for Title** box, type a title for your movie.

7. Under **More options**, click **Select audio or background music**. The **Add Audio or Background Music** dialog box will open. Click **Browse** to select a song from the folder you created on your C: drive.

8. Click **Done, edit movie** to start AutoMovie.

*AutoMovie can take up to 20 minutes to work, depending on the length of your video. When AutoMovie finishes editing, on the Preview Monitor, click Play to watch your video.*
Publishing Options

Send your movie by email
You can share your movies with friends and family by emailing them directly from Windows Movie Maker in Windows XP. You can send an email message with a low-resolution or high-resolution version of your movie attached.

To send an email of your movie in low resolution
1. In the Movie Tasks pane, under Finish Movie, click Send in e-mail.
2. The Save Movie Wizard will open and Movie Maker will automatically create a low-resolution version of your movie that can be attached to an email.
3. On the Ready to Send By e-mail page, click Next.
4. The Save Movie Wizard will create a blank email for you with the movie attached. If you want to preview the movie before you send it, you can double-click the attachment and the movie will open in a new window.
5. When you're ready, click Send. Recipients of your email message can watch the movie by double-clicking the attachment.

To send an email of your movie in high resolution
1. In Movie Maker, click the Tools menu, and then click Options.
2. In the Options dialog box, click the Advanced tab.
3. Under e-mail, click the up arrow to increase the maximum attachment size, and then click OK.

Upload your movie to the web
With Windows Movie Maker in Windows XP, you can save your movie on your computer, and then upload the video file to your classroom webpage.

To save and upload your movie
1. When you've finished your movie, save it.
2. Copy your completed movie file to your W: drive
3. Create a hyperlink on your webpage that points to the movie file stored in your W: drive.

Save your movie on a CD
After creating a movie in Windows Movie Maker, you can share it with your family and friends in several ways. Here's how to save your movie on a CD using the CD drive on your computer.

To save your movie
1. Insert a blank, recordable CD into your CD drive.
2. In Movie Maker, in the Movie Tasks pane, under Finish Movie, click Save to CD. The Save Movie Wizard will open.
3. On the Saved Movie File page, type a name for your movie, and then click Next.
4. On the Movie Setting page, click Next. Movie Maker will save your movie, and then eject your CD.
5. If you want to make another copy, insert a new blank, recordable CD, select the Save this movie to another recordable CD check box, and then click Next.
6. When you're done, click Finish.
Save your movie on a DVD
You can save a movie in Windows Movie Maker as a high-quality video file, and then burn (or write) that file to a DVD using a DVD burner (either an internal or external DVD burner) and video DVD burning software. You can then watch the DVD in almost any standard DVD player.

To save and burn your movie

1. In the Movie Tasks pane, under Finish Movie, click Save to my computer. The Save Movie Wizard will open.
2. On the Saved Movie File page, type a name for your movie, and then click Next.
3. On the Movie Setting page, click Show more choices, select the Other settings list, click DV-AVI, and then click Next. Movie Maker will save your movie.
4. On the Completing the Save Movie Wizard page, clear the Play movie when I click Finish check box, and then click Finish.
5. Follow the instructions for burning the DVD according to your DVD burning software.

Save your movie on your computer
You can save your movie as a file on your computer using Windows Movie Maker. This allows you to watch the movie by double-clicking it, which opens and plays it in Windows Media Player.

To save your movie

1. In the Movie Tasks pane, under Finish Movie, click Save to my computer. The Save Movie Wizard will open.
2. On the Save Movie File page, type a name for your movie, and then click Next.
3. On the Movie Setting page, click Next to accept the default setting Best quality for playback on my computer. Movie Maker will save your movie.
4. On the Completing the Save Movie Wizard page, click Finish.

If the Play movie when I click Finish check box is selected, the movie will automatically play in Windows Media Player.

Windows Movie Maker FAQ

Copyright

Anytime you are teaching with video or audio files, you have a responsibility to demonstrate ethical media use. Please be mindful of copyright regulations, and modeling ethical usage when you are searching for video and audio files.

Copyright is a sticky subject to explain – with many intricacies and exceptions to every rule. Any advice given in this manual is intended as a starting place for you to think carefully about your use of media in your classroom, and to give you resources for further study.

**Definition of Copyright:**

*The legal right granted to an author, a composer, a playwright, a publisher, or a distributor to exclusive publication, production, sale, or distribution of a literary, musical, dramatic, or artistic work.*

Copyright law protects the person who created the media, or the ideas of a person/company. If you use any published work, in a way that denies credit or income to the person who produced that work, you have violated copyright. And yet, there are some cases in which educators do have special permissions to use published work. These situations are covered by the term ‘Fair Use’.

**Types of Media and Permissible Amounts**

- **Motion media:**
  - Up to 10 percent of the total or three minutes, whichever is less.
- **Text material:**
  - Up to 10 percent of the total or 1,000 words, whichever is less.
  - An entire poem of less than 250 words may be used, but no more than three poems by one poet or five poems by different authors in an anthology. For poems exceeding 250 words, 250 words should be used but no more than three excerpts from one poet or five excerpts from different poets in the same work.
- **Music, lyrics, and music video:**
  - Up to 10 percent of the work but no more than 30 seconds of the music or lyrics from an individual musical work.
- **Illustrations or photographs:**
  - No more than five images from one artist or photographer.
  - No more than 10% or 15 images, whichever is less, from a collection.
- **Numerical data sets:**
  - Up to 10 percent or 2,500 fields or cell entries, whichever is less, from a copyrighted database or data table.
- **Copying of a multimedia project:**
  - No more than two copies may be made of a project.
Finding Images Online

Google

Many people turn here first, but not all of the images on Google are licensed for reuse- and there are tools that allow the photographer who originally took the photo to track down where it has been used. If you have not used it in accordance with the fair use policy, they can request that it is removed immediately – or they can pursue legal action against you.

To avoid this, use Google’s Advanced Image Search [http://www.google.com/advanced_image_search?hl=en](http://www.google.com/advanced_image_search?hl=en) and select the button next to Only images labeled for reuse.

Flickr

As the biggest photo sharing site on the web, used by some of the world's best photographers, your image search really isn't complete without a quick check of what Flickr has to offer. Like Google, you will need to visit the Advanced Search Page, then check "Only search within Creative Commons-licensed content" and any other license-related options you need before you begin. And when you find a photo you like, check on the right-hand side for a link like "Some rights reserved", and click it for details on what you can - and can't - do with the shot.
Finding Music Online

Freeplaymusic.com

This site has music clips that download as mp3 format, and will easily pop into your Windows Movie Maker video. You can preview the music on the site before you download, and you often get a choice of files depending on how long you want the clip to last.

On the site’s main page, you can start your search by selecting a CD, style or mood (feel) you want for your video.

Other options for music files would include using a CD you own, or downloading from various websites where you purchase the song you want.

However, not all of the sites download the music files into the correct format to be used with Windows Movie Maker. And, not all of the sites sell you a song with rights for reuse. Be aware of what you are purchasing, and be sure to read the next section on troubleshooting music files before you spend money on a song.
Troubleshooting Video Files

Windows Movie Maker can import the following file types:

The accepted formats for import are .WMV/.ASF, .MPG (MPEG-1), .AVI (DV-AVI), .WMA, .WAV, and .MP3.

If your camera’s video is of a different type, and small enough in size, you can convert it here:

http://video.online-convert.com/convert-to-wmv

Ignore the download button, and upload the video in the file field below it – or use the URL field to capture a video from an online source, such as YouTube.

Troubleshooting Music Files

When importing music files, you may occasionally find that some files will not show up in the import window. Sometimes this is due to file type mismatch. It can also be due to file protections that are in place to limit music piracy, or just plain old corruption.

When you have difficulty with a music file, start by checking the file type. This will mean looking at the files themselves, and discovering what the code is after the file name.

File types that are known to work with our version of Windows Movie Maker include:

- Uncompressed WAV and AIFF (.aiff, .aif, .aifc)
- Windows Media Audio .wma
- Microsoft's ASF
- MP3
- .snd, .au, .mpa, and .mp2

If your files are one of the above listed types, then it is possible that one of the following situations applies:

- You purchased your file from Napster, Yahoo! Music Engine, MTV URGE, MusicNow, BuyMusic
- You purchased from another site that sells WMA files with DRM.
- You purchased from Apple's iTunes Music Store.

Files purchased from these locations will not import into Windows Movie Maker.

Depending on how badly you want the file in your movie, there are some creative steps that you can use in recording/converting the file.

Here is an online tool for converting video files from one format to another: http://media.io/

Another good resource, for sound files, is Jake Ludington’s blog post “Adding Music to Windows Movie Maker”. The program he references in this blog post, Audacity, can be installed on your teacher computer if you fill out a software request form on the Technology SharePoint page

http://www.jakeludington.com/movie_maker/20061014_adding_music_to_windows_movie_maker.html